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One of the key challenges in Web development
is to invent artwork that clearly communicates

how to navigate through your site. Rollover
graphics, which change when the end

user’s mouse moves over them, are great
for adding visual cues that ensure your
audience knows an image has special
meaning or that it is a link. Rollovers
are also great if you have limited
space because you can put extra
information within the changing
graphic. For example, you could
make a button that says “Services,”
and when visitors place their mouse
over the word, it could change to list

the services you offer.

What you might not realize is that
rollovers are not written in standard

HTML. Instead, rollovers are written in 
a widely used scripting language invented

by Netscape, called JavaScript.

Dreamweaver MX 2004 automatically writes
JavaScript rollovers for you without you ever having 

to write the scripts or even understand how they are
constructed. This is great news, because a lot of people,

myself included, don’t know how to write JavaScript from scratch.
Alternately, I have trained many programmers who do know how to write JavaScript

by hand, but enjoy Dreamweaver MX 2004’s rollover capabilities because they can literally save days
of programming work. For this reason, the Dreamweaver MX 2004 rollover feature is helpful to both
the designer and the programmer.

11.
Rollovers

| Creating a Simple Rollover | Creating Pointer Rollovers | 

| Creating Multiple-Event Rollovers | Creating Flash Buttons | 

| Inserting a Navigation Bar Rollover |

chap_11
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Rollover Rules
Although this book provides many exercises that teach you how to implement rollovers, it is my hope
that you’ll move beyond the exercises to create your own custom rollover graphics once you get the
hang of this feature. If you plan to make your own rollovers from scratch, you should be aware of a few
important concepts.

Rollovers require a minimum of two graphics—an “off” state and an “on” state. Because this is a book
on Dreamweaver MX 2004, it doesn’t cover how to make the graphic component of rollovers. You need
an imaging program, such as Fireworks or Photoshop, to make the images. You’ll learn more about
creating graphics in Fireworks in Chapter 15, “Fireworks Integration.”

If you are going to make your own rollover graphics in an image editor, one important rule to under-
stand is that the graphics for the “off” state and “on” state for each of your rollover images must have
the same dimensions, or you risk that they will look distorted. JavaScript requires WIDTH and HEIGHT
information, which Dreamweaver MX 2004 will add for you automatically. If you have two different-
sized pieces of artwork, the JavaScript will scale both to the same width and height, causing distortion.
For this reason, all the images that are provided in this chapter’s exercises share the same dimensions,
as they should. ;-)
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Creating a Simple Rollover

This first exercise shows you how to create a simple rollover. These types of rollovers involve two pieces
of artwork. The first graphic appears on the screen initially, and the second appears when the mouse
“rolls over” it. In JavaScript terminology, this is called a swap image. But you will not be writing any
JavaScript from scratch, because Dreamweaver MX 2004 makes creating a simple rollover easier than
many other operations you’ve already learned.

1.

1. Define your site for Chapter 11. If you need a refresher on this process, revisit Exercise 1
in Chapter 3, “Site Control.”

2. Open simple_done.html in the chap_11 folder. Move your mouse over the symbol.
Nothing happens, right? Press F12 to preview the page. When you move your mouse over 
it in your Web browser, it changes to an alternate version of the symbol. You can only view 
a rollover inside a browser because Dreamweaver MX 2004 cannot preview rollovers within
its authoring environment. Return to Dreamweaver MX 2004 and close the file. You’ll learn
how to add the rollovers from scratch to an existing page in the following steps.

11. Rollovers | Dreamweaver MX 2004 H•O•T

Before the mouse
moves over the graphic

in the Web browser

After the mouse moves
over the graphic in the

Web browser
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3. From the Site panel, open simple.html in the html folder. Click inside the table cell shown above.
This places your cursor inside this specific table cell, which is where you want the rollover to be inserted.

4. Making sure the Common group of the Insert panel is selected, click and hold down your mouse
over the image icon. This will display a list of image objects that you can insert. From the drop-down
menu, choose Rollover Image to insert a rollover image in the table cell.
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5. The Insert Rollover Image dialog box will appear. In Image Name, type about. For the Original
Image, click Browse to select about_off.gif located inside the images folder. For the Rollover
Image, click Browse to select about_on.gif located inside the same folder. In the Alternate text box,
type Find out more about us! Make sure your dialog box looks just like the one above and click OK.

6. Repeat the process for the other rollovers using the frames, locations, and contact images found
in the images directory. Remember to give each image a unique name and an alt tag when inserting
the rollover.

With the image still selected, notice the hash mark (#) inside the Link area of the Property inspector.
Dreamweaver MX 2004 inserted this symbol in order to create a link, even though you didn’t specify
one. Why? Because a link is necessary for the JavaScript rollover to work. Putting a hash mark in the
Link area inserts a stand-in link that doesn’t link to anything. It simply acts as a placeholder so that
you can still click it and see the rollover.

7. Press F12 to preview the rollover. Notice that as you roll over the images, the corresponding “on”
image appears. Since you haven’t set any links yet, clicking on the rollovers won’t open up another
page. Return to Dreamweaver, save, and close the document.
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TIP | Creating Animated Rollovers

Throughout this exercise, you’ll learn different methods to insert and work with rollovers. In addi-
tion to what you’re learning here, you should experiment with rollovers to examine new ways your
user can interact with your pages. One such technique is an animated rollover. An animated
rollover is exactly the same as a static-image rollover, but it uses an animated GIF in one, or both,
of the rollover states. While this can add a nice touch to any page, you want to be careful to not
overdo it. In the case of animated GIFs, a little goes a long way. If your animated GIF is set to
loop, that is, play continuously, preloading the image is fine. If it is only supposed to play once,
make sure the Preload Rollover Image check box is unchecked when importing the image. If the
animated GIF preloads, the animation will play when preloaded, and by the time your user ends
up rolling over the image, it will no longer animate!

NOTE | Inserting Rollovers

As you’ll see later in this chapter, there are other ways to insert rollovers than the technique just
shown. Using the Insert Rollover feature, in my opinion, is certainly the most efficient. In addition
to inserting both image states, you also get to name the image (more on that later), give it an alt
tag, and set your link, all in one dialog box! Talk about saving time. :-)

MOVIE | rollover_list.mov

To see this exercise in action, check out rollover_list.mov, located in the movies folder on the
Dreamweaver MX 2004 H•O•T CD-ROM.
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Creating Pointer Rollovers

This next exercise shows you how to create pointer rollovers. Pointer rollovers reuse one piece of artwork
(in this example, the symbol that follows the mouse as you move over each word). This type of rollover
involves making a table to hold all the artwork in place. You’ll also get to use the Behaviors feature,
instead of the Insert Rollover Image object from the Insert panel. Are you feeling macho, or what?

2.

1. View the finished file first. Open pointer_done.html located in the chap_11 folder, and
press F12 to preview it inside a browser. When you’re finished, return to Dreamweaver MX
2004 and close the file. You’re going to re-create it using a handy table I’ve provided for you.
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2. Open pointer.html from the chap_11 folder, which already contains an empty table with nine rows
and two columns. When you are finished, you will have created a navigation bar that uses pointer
rollovers as a visual navigation aid. Notice that the right column of the table has our orange back-
ground color applied to it. These colored cells match the background of the graphics you will be insert-
ing here. I could have had you create this table from scratch, but I wanted to help you get to learning
about programming the rollovers faster.

3. Click inside Cell K and choose Insert > Image. Select blank.gif from the images folder, and then
click Open. The goal of the first part of this exercise is to insert the same blank.gif image in every
location that the pointer will appear. Why? Because rollovers require two images: the original state 
and the rollover state. In this instance, the original state looks like nothing, because it is a transparent
GIF that lets the background color show through. Be sure to choose the blank.gif image and not
blank1.gif, they are different sizes and would cause problems in your table.

4. Repeat this process three more times, inserting the same blank.gif file inside Cells M, O, and Q.
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5. After you have inserted the blank.gif image into the middle four cells on the right column of the
table, click on the image inside Cell K, as shown above. In the Property inspector, give it the name
blank1. It is essential that you assign a unique name to each image by selecting each instance 
of blank.gif and naming it, respectively, blank2, blank3, and blank4. Make sure to highlight the
appropriate blank.gif image when naming each graphic.

Note: In Exercise 1, Dreamweaver MX 2004 named the image as you inserted the rollover. When you
use the Swap Image behavior, you have to manually give each image a unique name, or the behavior
will not work. JavaScript needs an image name to refer to in the script; otherwise, it wouldn’t know
which image to swap. For this exercise, you’ll need to give a unique name to each image that will be
used in the Swap Image behavior. Be aware that names in Dreamweaver MX 2004 (or HTML) cannot
contain any spaces.

11. Rollovers | Dreamweaver MX 2004 H•O•T
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6. From the Assets panel, click the Images button if it is not already showing the image files. Click
inside Cell A and then drag nav1.gif from the Assets panel into this cell.

7. Click Cell B and insert the image nav2.gif by dragging it from the Assets panel. While nav2.gif is
selected, enter the name nav1 inside the Property inspector.
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8. Click Cell C and insert the image nav3.gif by dragging it into the cell from the Assets panel. Click
Cell D and insert the image nav4.gif from the Assets panel. While nav4.gif is selected, enter the name
nav2 inside the Property inspector.

9. Click Cell E and insert the image nav5.gif by dragging it into the cell from the Assets panel. Insert
nav6.gif inside Cell F. While nav6.gif is selected, enter the name nav3 inside the Property inspector.

10. Click Cell G and insert the image nav7.gif by dragging it into the cell from the Assets panel. Use
the Assets panel to insert the image nav8.gif inside Cell H. While nav8.gif is selected, enter the name
nav4 inside the Property inspector.
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11. To finish up our table, click Cell I and insert the image nav9.gif by dragging it into the cell from the
Assets panel. Take a moment to examine your finished table to make sure there are no gaps between
the images. If you see any, make sure you inserted the images into the proper cells.

This is what pointer.html looks like now.

12. Next, you will set the rollovers. Click nav2.gif (Home) to select it. Open the Behaviors panel 
(if it isn’t already open) by selecting Window > Behaviors or using the shortcut key (Shift+F3).

13. With nav2.gif (Home) still selected, click the plus sign above the Events column and select
Swap Image from the pop-up menu.
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14. In the Swap Image dialog box that opens, make sure the “blank1” image name is highlighted at
the top. Click Browse and select pointer.gif located in the images folder. Preload Images allows all
images to preload before a user mouses over them. Restore Images onMouseOut returns images to
their original state when the user takes the mouse off of the image. Both of these check boxes are
checked by default. Click Open (Windows) or Choose (Mac). In the Swap Image dialog box, click OK.

15. Next, select nav6.gif (frames) and click the plus sign in the Behaviors panel to select Swap
Image. Select image “blank2” from the Images list and click Browse to locate pointer.gif. Click
Open. Back in the Swap Image dialog box, click OK.

16. Repeat this process two more times as follows:

• For nav6.gif (Locations), select image “blank2.”

• For nav8.gif (Contact), select image “blank3.”
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17. Press F12 to preview in your browser. What you see should look just like the pointer_done.html
document you opened and previewed at the beginning of this exercise. To make yourself feel really
good, return to Dreamweaver MX 2004 and click the Code View button to view the code. Hey, you
didn’t have to write any of that! Click the Design View button to return to the Design view. Save and
close the file to move on to the next exercise.

In this exercise, you learned the benefit of using a table to hold together multiple graphics. It also
reinforced that you need two images for a rollover—the original state and the rollover state. In this
instance, the original was a blank image. When you program rollovers from the Behaviors panel, you
also must give each separate image a unique name, which you did several times in this exercise!
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Creating Multiple-Event Rollovers

A multiple-event rollover affects more than one piece of artwork in the Swap Image behavior. In this
example, two pieces of artwork change for every rollover. If that sounds complicated, it is! Assembling
this type of rollover can be tedious, but not nearly as tedious as writing all the HTML and JavaScript
from scratch.

3.

1. Open multiple_done.html located in the chap_11 folder, and preview this finished exercise
in your browser. Roll your mouse over each item in the list and watch the navigation button
change and an image appear at the top center of the navigation bar. This is a very impressive
type of rollover, and you (yes you!) are going to know how to do it as soon as you follow
along. Close this file.
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This image shows what the page looks like in Dreamweaver MX 2004.

2. Open multiple.html located in the chap_11 folder. This file includes an empty, pre-built table. You
learned to make a table similar to this in Chapter 7, “Tables.”
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3. Display the Assets panel and click the Images button if the images are not already showing. Click
inside Cell B (row 3, column 1) and drag about_off.gif into the cell. In the Property inspector, name
the image about.

4. Click inside Cell C (row 3, column 2) and drag the image frames_off.gif from the Assets panel into
the cell. In the Property inspector, name the image frames.
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5. Click inside Cell D (row 3, column 3) and drag the image locations_off.gif from the Assets panel
into the cell. In the Property inspector, name the image locations.

6. Click inside Cell E (row 3, column 4) and drag the image contact_off.gif from the Assets panel into
the cell. In the Property inspector, name the image contact.
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7. Click inside Cell A (row 2, column 2) and drag the image swap.gif from the Assets panel into the
cell. In the Property inspector, name the image swap.

This is what your page should look like now.
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8. If the Behaviors panel is not open, press Shift+F3 to open it. Select the image in Cell B (row 1,
column 1). With the image selected, click the plus sign in the Behaviors panel to select Swap Image.
In the Swap Image dialog box that opens, notice that “about” is selected in the Images list.

Be sure not to click OK just yet.

9. Click Browse to Set Source to: about_on.gif. This sets the rollover for the graphic about
(about_on.gif) to change to an alternate version of the button when you move your mouse over it.
Don’t click OK yet!
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10. Select “swap” from the same Images list. Click Browse again to Set Source to: m_about.gif,
then click Open. You just instructed the behavior to swap the swap (swap.gif) artwork to the picture
of the eyeglass frames (m_about.gif). Click OK!

The rollover now triggers two behaviors: the Tools button has been instructed to switch, and an image
of the eyeglass frames will appear when the mouse moves over the original About button image.

11. Press F12 and test your first rollover! Move your mouse over the About button. The button now
changes to the rollover, and the center image changes from a blank square to an image of eyeglass
frames. You’ve just set the rollover for the About button.

There are only three more items on the list to go.

12. Return to Dreamweaver MX 2004, and repeat this process for the next image. Select the Frames
image in Cell C. With the image selected, click the plus sign in the Behaviors panel and select Swap
Image. In the Swap Image dialog box that opens, notice that “frames” is selected in the Images list.

13. Click Browse to Set Source to frames_on.gif. Don’t click OK yet.

14. Select “swap” from the Images list. Click Browse to Set Source to m_frames.gif. Click OK!

Two more to go!

15. Select the Locations graphic. With the image selected, click the plus sign in the Behaviors panel
to select Swap Image. In the Swap Image dialog box that opens, notice that “locations” is selected
in the Images list.

16. Click Browse to Set Source to locations_on.gif. Don’t click OK yet.

11. Rollovers | Dreamweaver MX 2004 H•O•T

11DWMX2004 HOT(xxx-xxx)v1  11/8/03  3:56 PM  Page 22



| 23 |

17. Select “swap” from the Images list. Click Browse to Set Source to m_locations.gif. Click OK.

One more item to go!

18. Select the Contact Us graphic. With the image selected, click the plus sign in the Behaviors
panel to select Swap Image. In the Swap Image dialog box that opens, notice that “contact” is
selected in the Images list.

19. Click Browse to Set Source to contact_on.gif. Don’t click OK yet.

20. Select “swap” from the Images list. Click Browse to Set Source to m_contact.gif. Click OK.

21. You’re done. Press F12 to preview your work in a browser, then close the file and move on to the
next exercise.

What Are Flash Buttons?
Dreamweaver MX 2004 lets you create something called Flash Buttons. These buttons have very
similar characteristics to other rollovers that you have worked with in this chapter. For example, like
other rollovers, Flash Buttons have an Up state and Over state. They can be set up to link to other pages,
both internal and external. However, unlike other buttons, they are created from within Dreamweaver
MX 2004. This means that they can be quickly changed with just a few clicks, which can save you
time. You don’t need to use an image editor like Fireworks or ImageReady to work with Flash Buttons.

Creating Flash Buttons is fairly simple, as you will see by following the next exercise. What is different
is that Dreamweaver MX 2004 creates the rollover images in the SWF file format, instead of GIF or
JPG, after you click OK in the easy-to-use Flash Button interface. In other exercises, you have simply
worked with existing images and set the behavior to write the necessary JavaScript to enact a rollover.
With Flash Buttons, you are creating actual image files from Dreamweaver MX 2004. This can be
wonderfully convenient!

In order to view Flash content on the Web, you must have the Flash plug-in installed in your browser. 
If you don’t have this plug-in, you can download it for free at http://www.macromedia.com/software/
flashplayer/.

MOVIE | swap_image.mov

This isn’t the most intuitive operation in the universe, so don’t kick yourself if you don’t get it right
the first time. If you are interested in watching me perform the exercise, please view the movie
swap_image.mov, located in the movies folder on the Dreamweaver MX 2004 H•O•T CD-ROM.
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Creating Flash Buttons

Pros Explanation

Font integrity With Flash Buttons, you can use any font installed in your system, and
the visitors to your page don’t need to have that font installed. This
gives you much more flexibility when you are designing your pages.

Easily updated With just a few clicks, you can change the text and entire look of your
Flash Buttons. This can save you a lot of time when you need to make
changes to your site.

Complex animations Some of the Flash Buttons available to you in Dreamweaver MX 2004
have more complex animation than you could easily achieve with ani-
mated GIF files.

Design consistency Because a navigation system that uses Flash Buttons can be set up in
minutes, it’s easy to get a consistent look and feel to your site without a
spending a lot of time designing your own rollover art. This helps to
bring consistency to the overall design of your site.

Cons Explanation

Plug-in required All Flash content on the Web requires the Flash Player plug-in in order
to be viewed properly. Flash Buttons are no different.

Limited linking Certain types of links, called site-root relative links, don’t work with
Flash buttons. If you’re not sure what a site-root relative link is, don’t
worry, plenty of web designers go their whole careers without using
them. Just be aware that certain types of links don’t work with Flash
buttons.

Fixed button sizes Although the Flash buttons allow you to use any font installed in your
system and choose the font size, the buttons themselves don’t change
to fit the text. Often you’ll find your text too big for the button you’ve
chosen. Usually a small modification to your text can cause it to fit
inside the button, but you need to design with this limitation in mind.
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Creating Flash Buttons

Dreamweaver MX 2004 enables you to create Flash rollover buttons from a predefined set of styles,
without ever leaving Dreamweaver MX 2004. This exercise shows you how to work with this cool feature.

4.

1. Open the flash.html file located inside the chap_11 folder. This page contains a table at
the top that is set up to hold the Flash Buttons you will create this exercise.

2. Click inside the cell to the right of the laEyeworks logo in the first row of the table. You should
see a blinking cursor inside the cell. This indicates that your content will be inserted in this cell.

WARNING | Flash Plug-In Required

One advantage of Flash Buttons is that you can use any font you want and end users
do not have to have that font on their computers. All Flash content on the Web requires
that end users have the Flash plug-in installed in their browsers. According to Macromedia,
about 436 million people have a version of the plug-in installed. That’s a lot of people.
Different ways to detect whether users have this plug-in installed are described in
Chapter 14, “Behaviors.”
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3. From the Common Objects in the Insert panel, click and hold your mouse down on the Media
button. This will bring up the Media objects; click the Flash Button object. This will open the Insert
Flash Button dialog box.

The Insert Flash Button dialog box will display a preview of the button settings at the top of this dialog
box. As you select different styles, the Sample area will change. Moving your cursor over the Sample
area will display a preview of the rollover effect.

4. Under the Style option, select Beveled Rect-Bronze. This will change the Sample area at the top.
Move your mouse over the Sample area to preview the rollover effect for this style. For the Button
Text option, type About Us. This option defines the text you want to appear on the button. If you leave
this option blank, no text will appear on the button. Make sure the Font option is set to Verdana and
the Size option is set to 12.
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By default, the Flash Buttons will have a white background. You can use the eyedropper to match the
background of the buttons with other colors in your site, such as the background color.

5. Click the Bg Color box and move your mouse over the background of your document. This will let
you sample the orange color so that both backgrounds match.

6. In the Save As dialog box, type About.swf. This saves the new Flash Button in the same folder as
our HTML page.

Note: It may seem odd to save the file, but remember that you’re actually creating a SWF file each
time you add a Flash Button to your page. It also may not seem important to pay attention to where
you save this file, but there are some things about adding links to Flash Buttons that you need to be
aware of. Even though you are not linking your Flash Buttons in this exercise, you will link your Flash
Buttons to other pages 99% of the time. They are, after all, navigation items! When linking Flash
Buttons, it is best to save the SWF file in the same folder as the HTML page it resides on. It’s actually
a common practice to save all Flash content into a special folder in order to keep yourself organized.
Flash Buttons, however, are a little different. If you add a link to your Flash Button and try to save the
file into another directory, Dreamweaver will warn you that the link may not work in older browsers.
What’s worse, you have to describe the link relative to the location of the SWF file, not the HTML page
it’s on! Sound confusing? It can be! Just remember to save the Flash Button in the same directory as
your HTML page, and you’ll be fine.
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This is what the dialog box should look like at this point in the exercise.

7. Click OK to complete this process and create the Flash Button.

This is what your page should look like when the first button is inserted.
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8. Press Tab to move your cursor to the next table cell.

9. Using the same steps, create a Flash Button in each cell for the following options: Frames, Locations,
and Contact Us. Don’t forget to save each file, with a unique name, inside the same folder.

This is what your page should look like after you have added the other Flash Buttons.

10. Press F12 to preview this page in a browser. Return to Dreamweaver MX 2004. Save and close
this file.

MOVIE | flashbuttons.mov

To learn more about Dreamweaver MX 2004’s Flash Buttons feature, check out flashbuttons.mov,
located in the movies folder on the Dreamweaver MX 2004 H•O•T CD-ROM.
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Inserting a Navigation Bar Rollover

So far, you have created simple rollovers, multiple-event rollovers, and Flash Buttons. You have one
more type of rollover to learn to create before you finish this chapter—the navigation bar rollover. A
navigation bar-style rollover allows each button to display four states: up, over, down, and over while
down. Instead of working with two images for each rollover, this type of rollover requires that you work
with four, one for each separate state. This might sound intimidating, but the Dreamweaver MX 2004
Insert Navigation Bar feature makes it much easier than you might imagine.

5.

1. To view a sample of what you are about to create, open navbar_done.html located in 
the chap_11 folder. Press F12 to preview this page in a browser. Move your mouse over the
images and click a few as well. Notice there are more than two rollover states? This is what
you’ll learn to build in this exercise. Pretty neat-o!

2. Return to Dreamweaver MX 2004. Close navbar_done.html and open navbar.html
located in the chap_11 folder. This is simply a blank file that has been saved for you already.
You are going to use it as a starting point to create your own navigation bar.
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3. Select the Images dropdown menu from the Common objects panel. Choose the Navigation Bar
object. As an alternative, you could select Insert > Image Objects > Navigation Bar. Either way is
fine and will open the Insert Navigation Bar dialog box (and a big dialog box it is at that!).

Different Rollover States
Keeping track of the different types of rollover states can be a little tricky. Heck, I have a hard enough
time keeping track of my car keys, not to mention my rollover states. This chart outlines what the differ-
ent states mean:
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Rollover States

State What It Does

Up The graphic that appears on the Web page when it is loaded. This is also
referred to as the “static” or “off” state.

Over The graphic that appears when the end-user’s mouse moves over the image.
Most often, this image will revert back to the Up state when the mouse is
moved off of the image. This is sometimes referred to as the “on” state.

Down The graphic that will appear after the end user has clicked on the Over state.
This state will not change again until the end-user’s mouse moves over this
image or clicks on another image.

Over While Down This appears when the end-user’s mouse moves over the Down state. It works
just like the Over state, except that it works on the Down state only. Because
the user’s mouse is only depressed on a button for a short time, this state is
not used very often.
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This is what the Insert Navigation Bar dialog box looks like by default.

4. Enter Element Name: about. This assigns a name to the first rollover image in this navigation bar. Each
element (rollover) must have a unique name. I suggest you name them in relationship to their function
on the page. The first button will access the About Us page, so you will name this first element about.
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5. Click Browse next to the Up Image field. Browse to the images/navbar folder and select
about_up.jpg. Click Open to select this image. You’ve just specified the image for the Up state 
of the rollover.

6. Click Browse next to Over Image. Browse to the images/navbar folder and select about_over.jpg.
Click Open to select this image. You’ve just specified the image for the Over state of the rollover.

7. Click Browse next to Down Image. Browse to the images/navbar folder and select about_down.jpg.
Click Open to select this image. You’ve just specified the image for the Down state of the rollover.

8. Click Browse next to Over While Down Image. Browse to the images/navbar folder and select
about_overdown.jpg. Click Open to select this image. You’ve just specified the image for the Over
While Down state of the rollover. Do not click OK yet!
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This is what your screen should look like at this point in the exercise.

Now that you have added the first rollover button in your navigation, it’s time to add the next one. 
By the end of this exercise, this will all be second nature to you!

9. Click the plus sign at the top of the dialog box. You will see that a new unnamed element is added.
This will let you add the second rollover image to the navigation bar.

11. Rollovers | Dreamweaver MX 2004 H•O•T

11DWMX2004 HOT(xxx-xxx)v1  11/8/03  3:56 PM  Page 34



| 35 |

10. Enter Element Name: frames. This will assign a name to the second rollover image in this
navigation bar. Remember, each element must have a unique name.

11. Click Browse next to Up Image. Browse to the images/navbar folder and select frames_up.jpg.
Click Open to select this image. This option lets you specify the image for the Up state of the rollover
for the second element in the navigation bar.

12. Click Browse next to Over Image. Browse to the images/navbar folder and select
frames_over.jpg. Click Open to select this image. This option lets you specify the Over state 
of the second rollover.

13. Click Browse next to Down Image. Browse to the images/navbar folder and select
frames_down.jpg. Click Open to select this image. This option lets you specify the Down state 
of the second rollover.

14. Click Browse next to Over While Down Image. Browse to the images/navbar folder and select
frames_overdown.jpg. Click Open to select this image. This option lets you specify the Over While
Down state of the second rollover. Again, don’t click OK!

This is what your dialog box should look like with the second rollover settings.
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15. Now that you know how to add new elements to the navigation bar, go ahead and add two more
4-state buttons, using the chart above.

This is what the dialog box should look like when you are finished.
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Adding Elements to the Navigation Bar

Element State File

locations Up locations_up.jpg 
Over locations_over.jpg
Down locations_down.jpg
Over While Down locations_overdown.jpg

contact Up contact_up.jpg
Over contact_over.jpg
Down contact_down.jpg
Over While Down contact_overdown.jpg
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16. After you have added the fourth element, click OK. Dreamweaver MX 2004 will automatically
create a table, insert the images you specified, and create all of the complex JavaScript necessary for
the rollovers to function. It does all of this in about two seconds. I dare any JavaScript programmer to
compete with this time!

Here you can see the four possible states in the navigation bar.

17. Go ahead and press F12 to preview your navigation bar in a browser. Make sure you roll over each
of the images, click them, and then roll over them again to see the four different states of each.

18. Return to Dreamweaver MX 2004. Save and close the file.

Wow, another chapter under your belt, congratulations. I know it was a lot of hard work, but you are
well on your way to becoming a Dreamweaver MX 2004 expert.
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